
Baze de date – Microsoft Access 
 
1. APLICAREA OPERAȚIILOR ELEMENTARE ȘI A CONCEPTELOR DE BAZĂ ALE 
APLICAȚIEI ACCESS  
   
 1.1. CONCEPTUL DE BAZĂ DE DATE  
  În cea mai simplă formă, o bază de date reprezintă o colecţie de informaţii care este 
organizată într-o listă. De fiecare dată când realizăm o listă de informaţii, cum ar fi nume, adrese, 
produse sau facturi, se crează, de fapt, o bază de date.  
  O bază de date constă, deci, într-un ansamblu structurat de date înregistrate pe suporturi 
accesibile calculatorului pentru a satisface simultan mai mulţi utilizatori de o manieră selectivă şi 
într-un timp oportun.  
  Tehnic vorbind, nu este neapărat necesar să utilizăm un program de baze de date pentru 
crearea unei astfel de colecţii de date. Putem crea o listă de informaţii utilizând o mare varietate de 
programe, cum ar fi Microsoft Excel, Microsoft Word, chiar aplicaţia Notepad din Windows.  
  Spre deosebire de acestea, însă, un program de baze de date este mult mai puternic decât o 
simplă listă pe care o păstrăm pe o hârtie sau în cadrul unui document Word. Un program de baze 
de date oferă celui care îl utilizează diverse avantaje în plus, cum ar fi:  

 Stocarea informaţiilor: o bază de date păstrează colecţi de date şi informaţi care 
sunt legate de un anumit domeniu. Aceste colecţii pot conţine informaţi personale 
sau informaţii de afaceri. În plus, odată cu stocarea acestor informaţii, o bază de date 
trebuie să ofere posibilitatea de a adăuga noi date, de a le modifica sau şterge pe cele 
existente sau de a le organiza în funcţie de diverse criterii.   

 Căutarea informaţiilor: orice aplicaţie de baze de date trebuie să dea posiblitatea 
celui care o utilizează să regăsească informaţiile conţinute de aceasta cu uşurinţă şi 
foarte rapid. Astfel, otţi producătorii de astfel de aplicaţii sunt preocupaţi de 
minimizarea pe cât posibil a timpului de acces la datele conţinute de către bazele de 
date.   

 Analiza şi imprimarea informaţiilor: într-o bază de date se pot efectua diverse 
calcule, care ulterior pot forma diverse situaţii ce pot fi prezentate sub forma unor 
rapoarte pe suport de hârtie.   

 Partajarea informaţiilor: cele mai multe programe de baze de date permit lucrul 
simultan cu baza de date a mai multor utilizatori, care pot utiliza aceeaşi informaţie 
în acelaşi timp. Astfel de baze de date poartă denumirea de baze de date multiuser 
sau multiutilizator.   

    
  Un program sau aplicaţie care oferă posibilitatea lucrului cu baze de date cu toate avantajele 
prezentate anterior poartă denumirea de Sistem de Gestiune a Bazelor de Date, prescurtat S.G.B.D. 
El permite lucrul cu mai multe baze de date, în acelaşi format, de unde şi denumirea de sistem de 
gestiune. Un astfel de SGBD este şi aplicaţia Microsoft Access, distribuită de către firma Microsoft 
în pachetul de aplicaţii Office.  
 
O baza de date contine urmatoarele elemente: 

• Tabelul (table) – colectie de date inrudite, stocate pe linii si coloane; 

• Campul (field) – coloana din cadrul tabelului, care reprezinta cea mai mica unitate de date 
din cadrul bazei de date. 

• inregistrarea (record) – linia din cadrul tabelului. Linia este compusa din campuri si contine 
toate datele referitoare la un anumit element (dimensiuni, culori, greutati si alte 
caracteristici). 



• Obiect (object) – componenta individuala Access, cum ar fi un tabel, un formular, o 
interogare sau un raport. 

• Formular (form) – un obiect Access care afiseaza informatiile dintr-un tabel intr-un format 
diferit de cel al tabelului (altfel decat pe linii sau coloane). 

• Interogare (query) – Un obiect Access care stocheaza intrebari cu privire la datele stocate in 
baza de date. 

• Raport (report) – Un obiect Access care stocheaza detalii pentru afisarea sau tiparirea 
datelor in mod organizat. 

1.2.Deschiderea aplicaţei MS Access (2013) 

Start->All Programs->Microsoft Office-> Microsoft Office Access 2013 

sau, dacă există pictograma pe desktop, se execută dublu pe aceasta. 

 

1.3.Deschiderea unei baze de date existente 

Meniul File->Open->Se selectează baza de date care se doreşte a fi deschisă ->Open 

1.4.Modificarea bazei de date 

După ce a fost creată o bază de date, aceasta se poate modifica prin crearea de noi obiecte: tabele, 
interogări, rapoarte etc. De asemenea, operații de modificare a bazei de date pot fi efectuate cu 
ajutorul opțiunilor din meniul Edit: Copy, Cut, Delete, Rename care se aplica obiectelor conținute 
de baza de date.  

1.5.Salvarea şi închiderea unei baze de date existente 

Atunci cand se creează o bază de date nouă se deschide o fereastră, precum cea de mai jos, în care 
se cere introducerea denumirii bazei de date (secțiunea File name) și alegerea locației în care va fi 



salvată baza de date (secțiunea Save in). Crearea și, implicit, salvarea bazei de date se va face după 
apăsarea butonului Create. 

 

 

Observaţi că fişierul este salvat implicit de tipul Microsoft Office Access Database. 

 

 

 

1.6. Închiderea bazei de date 

Meniul File->Close   sau clic pe butonul de închidere al ferestrei. 



1.7. Închiderea aplicaţiei ACCESS 

File -> Exit  

 

1.8. Folosirea funcţiei “ajutor” 

Meniul Help->Microsoft Office Access Help F1, care va avea ca efect deschiderea casetei precum 
cea din figura alaturata. Se tasteaza textul dupa care se va face cautarea în sectiunea „Search For:”, 
dupa care se apasa tasta Enter sau se da clic pe butonul  

De exemplu, daca dorim sa aflam informatii din Help despre filtre, vom tasta cuvântul “filter”, dupa 
care apasam Enter. Se va deschide o noua fereastra ce contine rezultatul cautarii (Search Results), 
respectiv o lista de actiuni referitoare la filtre, din care vom selecta optiunea dorita.  . 

1.9.Moduri de vizualizare 

Din meniul View putem selecta preferinta pentru modul de vizualizare si anume: 

Database Objects- Afisarea in fereastra bazei de date a obiectelor de un anumit tip, pe care l-am 
selectat. De exemplu, în imaginea de mai jos sunt afisate tabelele pe care le contine baza de date 
db1 (Table1 si Verif), precum si modurile de lucru cu acestea. 

 

Large icons- Afisarea obiectelor sub forma unor pictograme marite. 

Small icons- Afisarea obiectelor sub forma unor pictograme micsorate. 

List - Afisarea obiectelor sub forma unei liste. 

Details- Afisarea obiectelor sub forma detaliata (descriere, data modificarii, data crearii, tipul).  

 

2. OPERAREA CU BAZE DE DATE 

2.1. Proiectarea unei baze de date 

Prin proiectarea unei baze de date înţelegem procesul de creare a unui proiect pentru baza de date 
care să asigure desfăşurarea corectă a activităţilor şi rezolvarea cerinţelor utilizatorului. 



Baza de date pe care o realizăm cu Microsoft Access este un fişier ce are extensia .mdb şi conţine 
următoarele obiecte: tabele (Tables), interogări (Query), formulare (Forms), rapoarte (Reports) şi 
macroinstrucţiuni (Macros). 

Pentru a creea o bază de date cu Microsoft Access: 

File->New->se alege din caseta din dreapta ecranului opţiunea Blank database -> se alege locaţia 
unde se va memora baza de date (în secţiunea Save in)->se tastează numele bazei de date în 
secţiunea File name a casetei care se deschide->clic pe butonul Create (sau se apasă tasta Enter). 

2.2. Crearea unei tabele 

Înainte de a crea o tabela trebuie sa cunoastem tipurile de date cu care lucreaza aplicatia Access: 

Tip Data  Descriere  
Text Text (set de caractere: litere, cifre, semne speciale - maxim 255). 

Lungimea implicita este 50.  
Memo Text de lungime mai mare de 255 caractere 
Number Numeric (întreg sau real) 
Date/Time Data calendaristica sau ora 
Currency Un numar cu doua zecimale, care are la sfârsit un simbol monetar 

(lei, euro etc.) 
AutoNumber Numar întreg care este incrementat automat pe masura ce sunt 

introduse noi înregistrari în tabela 
Yes/No Câmp de tip comutator, de tip Da/Nu, cu semnificatia Adevarat/Fals 
OLE Object Permite memorarea de imagini, sunete etc. 
Hyperlink Referinta catre un fisier extern 
Lookup Wizard... Permite crearea unei coloane de optiuni prestabilite din care putem 

selecta optiunea dorita atunci cand completam tabela cu date 

TIPURI DE FORMATE 

In afara de tipul sau, fiecare camp are optiuni de formatare pe care le poti configura. Acestea apar In 
jumatatea inferioara a casetei de dialog, In zona Field Properties. 

Optiunile de formatare se modifica In functie de tipul campului. 

Cele mai importante tipuri de formate: 

• FIELD SIZE – Numarul maxim de caractere pe care-l poate introduce un utilizator In acest 
camp (se aplica doar campurilor de tip Text). 

• FORMAT – O lista derulanta cu formatele disponibile pentru acel tip de camp. De 
asemenea, poti crea formate personalizate. 

• DECIMAL PLACES – Pentru campurile numerice, poti stabili numarul implicit de pozitii 
zecimale pe care le poate afisa un numar. 

• DEFAULT VALUE – Daca, In mod obisnuit, un camp contine o anumita valoare, poti 
introduce acea valoare aici pentru a economisi timp. Va aparea In fiecare noua Inregistrare 
si vei putea sa o Inlocuiesti In rarele ocazii cand nu este valabila. 

• REQUIRED – Alege YESsi NOpentru a comunica programului ACCESS daca i se permite 
unui utilizator sa lase acel camp necompletat. 

 



Crearea unei tabele înseamna doua operatii: definirea structurii si introducerea înregistrarilor. 
Definirea structurii presupune stabilirea câmpurilor tabelei: denumirea, tipul si proprietatile 
acestuia.  

Aceasta operatie poate fi realizata în trei moduri, asa cum se observa în figura:  

 

  Aici va fi tratat doar modul de creare fara procedura de asistenta si anume modul Design View, 
care este cel mai utilizat. 

Prin urmare, se executa clic pe Create table in design view, ceea ce determina deschiderea ferestrei 
de mai jos: 

 

Dupa cum se observa, aceasta fereastra este împartita în doua sectiuni orizontale: în partea 
superioara se precizeaza numele câmpului (coloana Field name), tipul – care reprezinta, de fapt, 
tipul datelor pe care le va contine (coloana Data Type) si descrierea acestuia (coloana Description) 
– care este optionala. Cea de-a doua sectiune contine proprietatile câmpului, grupate în doua 
categorii:  



General – pentru fiecare câmp creat, în functie de tipul de date ales, afiseaza  anumite proprietati 
ale acestuia: 

• Field size – reprezinta marimea zonei alocate coloanei. Implicit, pentru text sunt alocate 50 
caractere. 

• Format – reprezinta modul în care putem defini un sablon. 

• Input mask – introducerea unui sablon pentru a controla modul de introducere a datelor. De 
exemplu, daca se introduce simbolul 0 sau 9, impune introducerea unei cifre, L obliga 
introducerea unei litere etc. 

• Decimal places – precizarea numarului de zecimale. 

• Default values – valoarea introdusa în aceasta sectiune va fi valoarea implicita a câmpului 
înainte de editare. 

• Caption – denumirea sub care va aparea coloana în formularele sau rapoartele care vor fi 
create. Necompletarea acestei sectiuni determina afisarea numelui coloanei. 

• Validation rule – regula de validare a valorilor introduse. De exemplu, daca tabele va 
contine un câmp Nota, care sa reprezinte nota obtinuta de un elev, aceasta trebuie sa fie o 
valoare cuprinsa între 1 si 10, care se va scrie: >=1 and <=10. 

• Validation text – este  textul care va fi afisat în cazul introducerii unei valori care nu 
respecta restrictia impusa de regula de validare. 

• Required – specifica acceptarea sau respingerea valorilor nule într-o coloana. O valoare 
nula este o valoare 0 pentru o coloana de tip numeric sau currency, sirul vid “” pentru text, 
data vida #//# pentru tipul Date/Time, No pentru tipul logic Yes/No.  

• Allow zero length – permite sau nu tratarea unui sir de lungime zero drept valoare valida. 
Setarea acestei proprietati este independenta de proprietatea Required.  

• Indexed – indica prezenta sau absenta unui index pentru coloana. Pe valoarea No(No 
Duplicates), valorile permise sunt unice, iar pe valoarea Yes(Duplicates OK) valorile 
coloanei nu sunt unice. 

 Lookup– afiseaza tipul de instrument grafic prin intermediul caruia se afiseaza datele din acel 
câmp. Daca tipul câmpului a fost definit cu optiunea Lookup Wizard, atunci sunt afisate si alte 
informatii suplimentare. 

Exemplu: Pentru a retine în tabela Table1 urmatoarele informatii despre mai multe persoane: nume, 
prenume, CNP, adresa, nivel studii, vom proiecta urmatoarea structura a tabelei: 



  

Definirea tipului Lookup 

Microsoft Access ofera posibilitatea introducerii datelor într-un câmp dintr-o lista de valori din care 
alegem optiunea dorita. Elementele acestei liste pot fi introduse manual sau pot fi preluate automat 
dintr-un câmp al unei tabele sau dintr-o interogare. Pentru a crea un câmp de acest tip, în care vom 
introduce valorile manual, executam pasii urmatori: 

• selectam tipul câmpului Lookup Wizard; 

• din fereastra care se deschide selectam optiunea „I will type in the values what I want”, dupa 
care se executa clic pe butonul Next; 



 

• se stabileste numarul de coloane (de obicei, o singura coloana), apoi se introduc optiunile 
listei si se trece la pasul urmator (clic pe Next); 

 

• se confirma coloana fixata ca fiind de tip cautare si se salveaza definitia coloanei (clic 
Finish). 

Dupa ce a fost definit fiecare câmp, se salveaza tabela si se închide. Daca operatia de salvare nu a 
fost efectuata înainte de închiderea tabelei, Microsoft Access va deschide o caseta în care trebuie sa 
confirmam sau nu salvarea tabelei create. 

Pentru a completa tabela cu înregistrari se executa dublu clic pe numele tabelei, care este afisat în 
fereastra care contine obiectele bazei de date.  

Cheia primară 



Este un câmp care identifică în mod unic înregistrările unei tabele. De exemplu, putem avea două 
persoane cu acelaşi nume, dar ele se identifică în mod unic prin CNP.  

Pentru a stabili un câmp drept cheie primară în modul Design View, executăm clic dreapta pe 
numele câmpului care dorim să devină cheia tabelei şi selectăm Primary Key din meniul contextual 
sau apăsăm butonul  de pe bara de pictograme. 

 

Dacă vor fi folosite mai multe câmpuri pentru cheie primară, trebuie selectate toate şi apoi apăsat 
butonul Primary Key.  

Dacă am salvat tabela fără să fixăm cheia primară, Access ne va avertiza în legătură cu acest aspect. 
Putem reveni în modul Design şi ataşăm cheia unui câmp sau putem accepta ataşarea automată a 
unui câmp de tip AutoNumber cu rol de cheie primară, pe care-l va numi ID. 

Stabilirea unui index 

Indexarea unei tabele reprezinta operatia prin care se ordoneaza logic înregistrarile acesteia, dupa 
un anumit atribut (sau ale unui grup de atribute), numit index, în scopul optimizarii cautarii si 
localizarii ulterioare a anumitor date. Indexul se defineste la definirea structurii tabelei. Cheia 
primara este considerata automat index. 

Pentru stabili un index pentru un câmp, setam proprietatea Indexed acelui câmp (din Field 
Properties) pe valoarea Yes(No Duplicates).  

Pentru a crea un index cu mai multe câmpuri procedam în modul urmator: 

• deschidem tabela în modul Design View 

• executam clic pe butonul Index de pe bara de pictograme. Aceasta are ca efect 
deschiderea ferestrei de definire a indecsilor, în care este deja cuprinsa cheia primara. Putem 
defini si alti indecsi, completând numele indexului, numele câmpului si ordinea sortarii 
(crescator sau descrescator): 



 

Un index poate avea pâna la maxim 10 câmpuri. 

Daca dorim sa anulam un index, executam clic dreapta pe numele indexului si alegem Delete Rows. 

Modificarea proprietatilor unui câmp 

Se deschide tabela în modul Design View, se selecteaza câmpul, apoi se modifica proprietatile 
acestuia din sectiunea Field Properties si se salveaza modificarile. 

Introducerea de date în tabela 

Se deschide tabela (Open sau dublu click pe numele tabelei din fereastra ce contine obiectele bazei 
de date), dupa care se completeaza cu articole corespunzatoare câmpurilor  care au fost definite.  

 

Vizualizarea informatiilor dintr-o tabela 

Fie se executa dublu click pe numele tabelei din fereastra ce contine obiectele bazei de date, fie se 
executa clic pe butonul Open, fie clic dreapta pe numele tabelei->Open. 



 

Modificarea datelor într-o tabela 

Se cauta înregistrarea care se doreste a fi modificata, se executa clic în fiecare celula care trebuie 
modificata, apoi se salveaza tabela. 

Adaugarea de înregistrari într-o tabela 

Fie ne deplasam la sfârsitul tabelei, fie alegem din meniul Insert->New Record si completam toate 
celulele de pe coloanele tabelei. 

Stergerea înregistrarilor dintr-o tabela 

Se selecteaza înregistrarea si se selecteaza Edit->Delete (sau Delete Record) sau clic dreapta in 
dreptul înregistrarii, pe marginea rândului->Delete Record. Se va cere confirmarea stergerii. 

 

3. CREAREA SI UTILIZAREA FORMULARELOR 

3.1.Crearea unui formular simplu 

Formularul este o interfata între utilizator si tabela, fiind utilizat pentru introducerea datelor, însa 
poate avea si rol de meniu sau de prezentare generala a informatiilor. 

Proiectarea formularelor cu Form Wizard 

Se alege obiectul Form, apoi optiunea Create form by using wizard. Se va deschide o fereastra ca 
cea de mai jos, unde se va alege tabela sau interogarea pe baza careia va fi creat formularul. În 
continuare, se selecteaza câmpurile care vor fi continute în formular, executând clic pe câmp, apoi 
clic pe sageata orientata spre dreapta. Daca dorim sa cuprindem toate câmpurile unei tabele, 
executam clic pe sageata dubla. 



 

Daca formularul va cuprinde câmpuri din doua tabele, se deschide fiecare tabela pe rând. 

Urmatorul pas consta în alegerea aspectului machetei, se da un nume formularului si se închide 
fereastra apasând Finish. Modificarea lui se face în modul Design. 

Crearea formularelor în Design View 

Se execută dublu clic pe opţiunea Create form in Design View, care va avea ca efect deschiderea 
unui formular în faza de proiectare (modul Design View). Se execută clic pe pictograma Properties. 
Implicit, această fereastră este setată pe secţiunea Detail. Vom schimba opţiunea aceasta cu 
opţiunea Form şi apoi, de la proprietatea Record Source vom selecta tabela pentru care creăm 
formularul. In momentul selectării tabelei, se va dechide o casetă ce conţine toate câmpurile 
acesteia. Folosind tehnica drag&drop plasăm cîmpurile dorite pe suprafaţa de lucru a formularului. 
Observăm că, odată cu trecerea unui câmp este trecută automat şi eticheta care are acelaşi nume ca 
şi câmpul. Obiectele pot fi manevrate atunci când, la trecerea peste obiect,cursorul mouse-ului se 
transformă în mânuţă. De asemenea, putem separa eticheta de câmp când forma cursorului este o 
mânuţă cu degetul arătător întins.  



 

Putem adăuga şi alte obiecte în formular folosind caseta de instrumente (Toolbox) care se află în 
partea stângă a ecranului. Beneficiem, de asemenea, şi de asistenţă din partea wizard-ului la crearea 
unor obiecte (Command button, Combo box, List box). De exemplu, pentru a crea un buton pentru 
adăugarea unei înregistrări, se execută clic pe pictograma , apoi pe pictograma Command 
button. Cu butonul stâng al mouse-ului apăsat se trasează o zonă dreptunghiulară în locul unde se 
doreşte plasarea obiectului. La eliberarea butonului se deschide lista de comezi. Vom selecta din 
secţiunea Categories opţiunea Record operations, iar din secţiunea Actions se selectează Add new 
record->Next. Schimbăm textul asociat butonului din Add record în Adăugare->Next->Finish.  

Pentru a crea un grup de opţiuni ca în figura alăturată:  



 

• Se selectează pictograma Option Group de pe caseta cu 
instrumente şi se trasează o zonă dreptunghiulară pe spaţiul 
formularului 

• Se selectează pictograma Option Button şi se trasează butoanele 
radio 

• Se modifică textul corespunzător 

 

Introducerea datelor în baza de date utilizând formulare simple 

Prin intermediul formularelor, un utilizator al unei baze de date MS Access poate simplifica 
procesul de introducere a datelor şi poate reduce apariţia erorilor la introducerea datelor.  
Pentru a realiza operaţia de introducere a datelor, se execută clic pe butonul , care are ca efect 
saltul la sfârşitul bazei de date şi creearea unei înregistrări vide care urmează a fi completată. 
Operaţia se repetă de câte ori este necesar.  

Formatarea textului 

Se deschide formularul în modul Design View şi se selectează textul (eticheta sau câmpul) care se 
formatează.în momentul selectării se activează bara de pictograme Formatting(Form/Report). 
Formatarea textului este cea specifică aplicaţiilor Microsoft Office. 



 

Schimbarea culorii fondului într-un formular 

Se deschide formularul în modul Design View, se selectează eticheta şi/sau câmpul căreia/căruia i 
se aplică fundal şi se execută clic pe pictograma Fill, după ce, în prealabil, a fost aleasă culoarea. 
Pentru a aplica fundal formularului, se execută clic în spaţiul liber din formular şi se procedează în 
mod similar. De precizat că aplicarea culorii de fundal pentru formular (background-ul) se poate 
realiza doar dacă nu a fost ales un model predefinit atunci când acesta a fost creat (dacă la crearea 
formularului cu wizard nu se parcurg toţi paşii şi se apasă Finish după ce au fost stabilite câmpurile 
ce vor apărea în formular). Pentru a schimba background-ul cu altul predefinit, se selectează 
opţiunea Autoformat din meniul Format. 

 



Importul unei imagini sau fişier text într-un formular  
Se selectează pictograma Image de pe caseta cu instrumente, se trasează o zonă dreptunghiulara cu 
mouse-ul (drag&drop). La eliberarea butonului se deschide o fereastră care permite căutarea şi 
selectarea imaginii dorite. Se poate redimensiona cu mouse-ul.  
Pentru a importa un fişier text fie se selectează din meniul Insert opţiunea Object..., fie se foloseşte 
de pe Toolbox pictograma Unbound Object Frame  

. 

Efectul este deschiderea ferestrei următoare:  

 

Se selectează opţiunea Create from file, se selectează fişierul text din fereastra care se deschide. 
Fişierul poate fi legat (caz în care bifăm opţiunea Link) sau inclus. Dacă dorim să apară în formular 
sub forma unei pictograme vom selecta opţiunea Display as Icon. Acest document poate fi editat 
direct de pe formular, în modul Design view, dacă se execută clic dreapta pe el şi se selectează din 
meniul contextual deschis opţiunea Linked Document Object, ca în figură.  



 

Modificarea modului de aranjare a obiectelor în formular  
Se deschide formularul în modul design View. Se selectează obiectul cu mouse-ul (executăm clic pe 
obiect) şi folosind tehnica drag&drop îl plasăm în locul dorit pe formular.  
  

Conectarea la o bază de date existentă 
Conectarea formularului se va face la o tabelă sau la o interogare (query) a bazei de date în care se 
lucrează, în scopul preluării anumitor câmpuri ale acesteia, aşa cum a fost precizat la capitolul 
Crearea formularelor în Design View:  

• Se deschide formularul în modul Design View; 

• Se execută clic pe pictograma Properties de pe bara de pictograme (sau clic dreapta într-o 
zonă liberă din secţiunea Detail si alegem din meniul local Properties); 

• în fereastra care se deschide selectăm Form în loc de Detail din lista ascunsă;  

• De la proprietatea Record Source vom selecta tabela/interogarea pentru care creăm 
formularul(clic pe sageata de la lista ascunsa). In momentul selectării tabelei/interogării, se 
va deschide o casetă ce conţine toate câmpurile acesteia.  



.  

Caseta ce conţine câmpurile tabelei/interogării se poate deschide şi din meniul View->Field list 
(având formularul deschis tot în modul Design View).  

Căutarea unei înregistrări 

Se deschide formularul în modul Form View şi din meniul Edit se alege Find... Ca efect, se 
deschide fereastra Find and Replace. Vom introduce cuvântul căutat (în cazul nostru este, de fapt, o 
înregistrare) în secţiunea Find What, apoi în secţiunea Look in vom selecta formularul (Form). 
Pentru a determina căutarea se execută clic pe butonul Find Next.  



 

Vom observa că în formular este acum adusă înregistrarea pe care am căutat-o. 

 

4. UTILIZAREA INFORMATIILOR DINTR-O BAZA DE DATE 

4.1.Interogări (Query)  
Interogările reprezintă modalităţi de selecţie şi afişare a informaţie din unul sau mai multe surse 
(tabele sau alte interogări), formulate cu ajutorul unor condiţii logice.  
Tipuri de interogări 
În funcţie de modul de definire şi rezultatele acţiunii, interogarile pot fi clasificate astfel:  

1. interogări simple sau de selecţie (folosind condiţii logice); 

2. interogări pentru actualizare - delete query, update query şi append query; 

3. interogări încrucişate sau bidimensionale. 
Rezultatul interogării este un nou set de date, numit set dinamic (engl: Dynaset). Setul dinamic 
(rezultalul interogării) conţine doar câmpurile specificate ale înregistrarilor din tabelele specificate 
care satisfac condiţiile specificate. Denumirea '"Set dinamic" este legată de faptul că orice 
modificări ale datelor din tabelele specificate în interogare implică modificări corespunzătoare ale 
rezultatului interogării (la o nouă executare a ei) şi invers, orice modificări în setul dinamic implică 
modificări în tabelele respective (cu condiţia respectării integrităţii datelor). Seturile de date 
dinamice nu se memorează; ele se formează din nou de fiecare dată când executăm o interogare. 
Dacă în tabelele bazei de date intervin modificări, rezultatele executării a două interogari identice 
pot fi diferite.  

Crearea unei interogări simple (de selecţie a înregistrărilor -Select Query)  



Pentru a defini o interogare de selecţie selectăm opţiunea Queries din fereastra Database, apoi 
butonul Create query in design view.  

 

Ca efect, va apărea fereastra alăturată, din care selectăm consecutiv (în orice ordine) tabelele 
necesare şi pentru fiecare acţionăm butonul Add. După selectarea tabelelor / interogărilor acţionăm 
butonul Close.  

 

În situaţia în care, după ce au fost stabilite sursele care vor fi interogate, dorim să revenim asupra 
lor şi să le schimbăm, avem la dispoziţie opţiunile meniului Query, cu menţiunea că pentru a 
înlătura o sursă trebuie mai întâi să o selectăm şi apoi să alegem Remove: 



 

sau dăm clic dreapta pe sursă şi alegem Remove: 

 

Dacă tabelele au câmpuri comune (definite în procesul creării lor), Access stabileşte în mod 
automat legăturile respective. În continuare indicăm, în partea de jos a ferestrei, câmpurile din 
fiecare tabel (în ordinea dorită), care urmează a fi afişate sau pentru care se vor specifica condiţii de 
selecţie şi / sau de sortare. Includerea câmpurilor se face prin "tragerea" lor cu ajutorul mouse-ului 
din tabelele din caseta de sus în rândul Field al casetei de jos sau prin executarea unui dublu-clic pe 
denumirile respective. După aceasta, specificăm condiţiile selecţiei şi / sau ordinea sortării, în acest 
fel interogarea se consideră definită. 

 

În rândul Criteria din partea de jos a ferestrei specificăm condiţia selecţiei. Dacă dorim ca 
înregistrările să fie afişate într-o anumită ordine (crescătoare / alfabetică sau descrescătoare), pentru 
câmpurile respective specificăm opţiunile Ascending sau Descending în rândul Sort. 

Interogarea astfel definită poate fi executată imediat în scopul obţinerii rezultatului, sau salvată 
pentru a fi executată ulterior. În primul caz, actionăm butonul (Datasheet View) din bara cu 
instrumente sau opţiunea Datasheet View din meniul View, în al doilea caz executăm comanda 
Save din meniul File. La salvarea interogării indicăm numele ei, care nu trebuie să coincidă cu 
numele unor tabele sau ale unor interogări definite anterior.  

Interogări de acţiune: Delete Query, Update Query şi Append Query 

Interogari de excludere (ştergere) a unor înregistrări (Delete Query) 



1. Creăm interogarea în modul Design View: selectăm Query din fereastra Database şi alegem 
modul de proiectare Design View. 

2. Includem tabela pentru care se execută interogarea. 

3. Selectăm Delete Query din meniul Query. Ca rezultat, titlul ferestrei se schimbă în Delete 
Query, iar în partea de jos a ferestrei apare rândul Delete. 

4. Din lista câmpurilor tabelei, care apare afisată în partea de sus a ferestrei, selectăm 
câmpurile care vor fi afişate în interogaresau pentru care vor fi specificate condiţii de 
selecţie şi le "tragem" în celulele respective ale liniei Field din partea de jos. Ca rezultat, în 
celulele respective apare automat, pentru fiecare câmp, opţiunea Where (din engleza - Unde, 
ín care). 

5. Introducem în celulele liniei Criteria condiţiile selecţiei (condiţiile pe care trebuie să le 
îndeplinească înregistrările care vor fi şterse, în dreptul câmpului corespunzător).  

6. Pentru a obţine lista înregistrărilor care urmează a fi excluse (dar încă n-au fost excluse), 
vizualizăm interogarea în modul Datasheet View.  

7. Dacă rezultatele obţinute sunt cele dorite, revenim în modul Design View pentru a elimina 
realmente înregistrările, selectând comanda Run din meniul Query. Ca rezultat, pe ecran 
apare un mesaj de informare despre numărul total al inregistrarilor care urmează a fi 
eliminate. Dacă acţionăm butonul Yes, înregistrările vizate sunt eliminate definitiv. Pentru 
renunţare, acţionam butonul No. 

8. Salvăm interogarea. 
Exemplu:  
Pentru tabela următoare: 

 
 
 
Eliminarea persoanelor care au studii "Liceale": 
 

 
Interogări de actualizare a înregistrărilor (Update Query) 
Se utilizează în cazul în care este necesară modificarea unui număr mare de înregistrari, respectând 
aceeaşi modalitate de modificare. Vom descrie în continuare modul de definire a unei interogări de 
actualizare.  

1. Creăm interogarea în modul Design View: selectăm Query din fereastra Database şi alegem 
modul de proiectare Design View. 

2. Includem tabela pentru care se execută interogarea. 

3. Selectăm Update Query din meniul Query. Ca rezultat, titlul ferestrei se modifică în Update 
Query, iar în partea de jos apare rândul Update To. 



4. Includem (prin “tragere”) în celulele rândului Field câmpurile care dorim să apară în 
interogare sau cele pentru care vom stabili criterii de actualizare. 

5. Pentru ca anumite câmpuri ale tabelei să fie afişate în interogarea de actualizare trebuie să 
introducem în rândul Update To numele câmpului cuprins între paranteze drepte, altfel 
acesta nu va fi afişat. De asemenea, putem completa automat un câmp calculat, care nu a 
fost completat iniţial în tabelă. De exemplu, dacă avem tabela Medii, care are câmpurile: 
Numele şi prenumele elevului, Media sem I, Media Sem II şi Media generală, iar câmpul 
Media generală nu a fost completat iniţial pentru nici o înregistrare, vom trece în dreptul 
câmpului Media generală de pe rândul Update: ([Media sem I]+[Media sem II])/2. 

 

6. Introducem în rândul Criteria condiţia pe care trebuie să o îndeplinească înregistrările care 
vor fi modificate. 

7. Vizualizăm interogarea în modul Datasheet View pentru a vedea modificările care se vor 
face. Modificările propriu-zise vor fi operate numai la revenirea în modul Design View şi 
executarea comenzii Run din meniul Query. ín acest caz, pe ecran va apărea un mesaj despre 
numarul total al înregistrărilor care urmează a fi modificate. Acţionând butonul Yes, Access 
va efectua modificările. Pentru a renunţa la modificări, acţionăm butonul No . 

Observaţie: Interogarile de tip Update se execută, de regulă, o singură dată. ín cazul executării 
repetate a interogării, de exemplu aplicarea unei scumpiri de 2% la pretul unor produse, această 
majorare va fi realizată la fiecare execuţie a interogării.  
Interogări de adăugare a înregistrărilor (Append Query) 
Se utilizează în cazul în care este necesară adăugareavunui set de înregistrări dintr-o tabelă în altă 
tabelă. Aceasta va selecta datele care tebuie adăugate şi le va trimite în câmpurile tabelei destinaţie. 
Vom descrie în continuare modul de definire a unei interogări de adăugare.  

1. Creăm interogarea în modul Design View: selectăm Query din fereastra Database şi alegem 
modul de proiectare Design View. 

2. Includem tabela pentru care se execută interogarea. 

3. Includem (prin "tragere") în celulele rândului Field câmpurile care dorim să apară în 
interogare sau cele pentru care vom stabili criterii de adăugare. 

4. Selectăm Append Query din meniul Query. Indicăm tabela destinaţie.  

 
Ca rezultat, titlul ferestrei se modifică în Append Query, iar în partea de jos apare rândul 
Append To. 



5. Introducem în rândul Criteria condiţia pe care trebuie să o îndeplinească înregistrările care 
vor fi preluate. 

6. Precizăm pe linia Append To numele câmpului destinaţie (doar în cazul în care nu au acelaşi 
nume). 

7. Vizualizăm interogarea în modul Datasheet View pentru a vedea modificările care se vor 
face. Modificările propriu-zise vor fi operate numai la revenirea în modul Design View şi 
executarea comenzii Run din meniul Query. 

 
Interogari incrucişate (Crosstab Query) 
Pentru a defini o interogare încrucişată, procedăm iniţial ca şi în cazul creării unei interogări simple 
în modul Design View, apoi urmăm paşii:  

1. Selectăm opţiunea Crosstab din meniul Query. Ca rezultat, titlul ferestrei se schimbă in 
Crosstab Query, iar in partea de jos apare rândul Crosstab. 

2. Stabilim câmpurile ale căror valori vor deveni denumiri ale rândurilor tabelului obţinut în 
urma interogării. Pentru aceasta, acţionăm butonul cu sageată din rândul Crosstab pentru 
fiecare dintre câmpurile alese în acest scop şi, din lista derulantă care apare, selectăm 
optiunea Row Heading.  

3. Stabilim, în mod similar, câmpul ale cărui valori vor deveni denumiri ale coloanelor 
tabelului, alegând de data aceasta opţiunea Column Heading. Acesta va fi câmpul pentru 
care se aplică "încrucişarea". Acest câmp va trebui să apară de două ori în interogare, aşa 
cum se vede în figura de mai jos: 



 

4. La a doua apariţie a câmpului, în rândul Total înlocuim opţiunea Group By cu operatorul 
Count, iar în rândul Crosstab stabilim optiunea Value pe care o selectam din lista derulanta. 

5. Vizualizăm rezultatul în modul Datasheet View. 

 
Interogări (Query)  
Interogările reprezintă modalităţi de selecţie şi afişare a informaţie din unul sau mai multe surse 
(tabele sau alte interogări), formulate cu ajutorul unor condiţii logice.  
Tipuri de interogări 
În funcţie de modul de definire şi rezultatele acţiunii, interogarile pot fi clasificate astfel:  

1. interogări simple sau de selecţie (folosind condiţii logice); 

2. interogări pentru actualizare - delete query, update query şi append query; 

3. interogări încrucişate sau bidimensionale. 
Rezultatul interogării este un nou set de date, numit set dinamic (engl: Dynaset). Setul dinamic 
(rezultalul interogării) conţine doar câmpurile specificate ale înregistrarilor din tabelele specificate 
care satisfac condiţiile specificate. Denumirea '"Set dinamic" este legată de faptul că orice 
modificări ale datelor din tabelele specificate în interogare implică modificări corespunzătoare ale 
rezultatului interogării (la o nouă executare a ei) şi invers, orice modificări în setul dinamic implică 
modificări în tabelele respective (cu condiţia respectării integrităţii datelor). Seturile de date 
dinamice nu se memorează; ele se formează din nou de fiecare dată când executăm o interogare. 
Dacă în tabelele bazei de date intervin modificări, rezultatele executării a două interogari identice 
pot fi diferite.  

Crearea unei interogări simple (de selecţie a înregistrărilor -Select Query)  



Pentru a defini o interogare de selecţie selectăm opţiunea Queries din fereastra Database, apoi 
butonul Create query in design view.  

 

Ca efect, va apărea fereastra alăturată, din care selectăm consecutiv (în orice ordine) tabelele 
necesare şi pentru fiecare acţionăm butonul Add. După selectarea tabelelor / interogărilor acţionăm 
butonul Close.  

 

În situaţia în care, după ce au fost stabilite sursele care vor fi interogate, dorim să revenim asupra 
lor şi să le schimbăm, avem la dispoziţie opţiunile meniului Query, cu menţiunea că pentru a 
înlătura o sursă trebuie mai întâi să o selectăm şi apoi să alegem Remove: 



 

sau dăm clic dreapta pe sursă şi alegem Remove: 

 

Dacă tabelele au câmpuri comune (definite în procesul creării lor), Access stabileşte în mod 
automat legăturile respective. În continuare indicăm, în partea de jos a ferestrei, câmpurile din 
fiecare tabel (în ordinea dorită), care urmează a fi afişate sau pentru care se vor specifica condiţii de 
selecţie şi / sau de sortare. Includerea câmpurilor se face prin "tragerea" lor cu ajutorul mouse-ului 
din tabelele din caseta de sus în rândul Field al casetei de jos sau prin executarea unui dublu-clic pe 
denumirile respective. După aceasta, specificăm condiţiile selecţiei şi / sau ordinea sortării, în acest 
fel interogarea se consideră definită. 

 

În rândul Criteria din partea de jos a ferestrei specificăm condiţia selecţiei. Dacă dorim ca 
înregistrările să fie afişate într-o anumită ordine (crescătoare / alfabetică sau descrescătoare), pentru 
câmpurile respective specificăm opţiunile Ascending sau Descending în rândul Sort. 

Interogarea astfel definită poate fi executată imediat în scopul obţinerii rezultatului, sau salvată 
pentru a fi executată ulterior. În primul caz, actionăm butonul (Datasheet View) din bara cu 
instrumente sau opţiunea Datasheet View din meniul View, în al doilea caz executăm comanda 
Save din meniul File. La salvarea interogării indicăm numele ei, care nu trebuie să coincidă cu 
numele unor tabele sau ale unor interogări definite anterior.  

Interogări de acţiune: Delete Query, Update Query şi Append Query 

Interogari de excludere (ştergere) a unor înregistrări (Delete Query) 



1. Creăm interogarea în modul Design View: selectăm Query din fereastra Database şi alegem 
modul de proiectare Design View. 

2. Includem tabela pentru care se execută interogarea. 

3. Selectăm Delete Query din meniul Query. Ca rezultat, titlul ferestrei se schimbă în Delete 
Query, iar în partea de jos a ferestrei apare rândul Delete. 

4. Din lista câmpurilor tabelei, care apare afisată în partea de sus a ferestrei, selectăm 
câmpurile care vor fi afişate în interogaresau pentru care vor fi specificate condiţii de 
selecţie şi le "tragem" în celulele respective ale liniei Field din partea de jos. Ca rezultat, în 
celulele respective apare automat, pentru fiecare câmp, opţiunea Where (din engleza - Unde, 
ín care). 

5. Introducem în celulele liniei Criteria condiţiile selecţiei (condiţiile pe care trebuie să le 
îndeplinească înregistrările care vor fi şterse, în dreptul câmpului corespunzător).  

6. Pentru a obţine lista înregistrărilor care urmează a fi excluse (dar încă n-au fost excluse), 
vizualizăm interogarea în modul Datasheet View.  

7. Dacă rezultatele obţinute sunt cele dorite, revenim în modul Design View pentru a elimina 
realmente înregistrările, selectând comanda Run din meniul Query. Ca rezultat, pe ecran 
apare un mesaj de informare despre numărul total al inregistrarilor care urmează a fi 
eliminate. Dacă acţionăm butonul Yes, înregistrările vizate sunt eliminate definitiv. Pentru 
renunţare, acţionam butonul No. 

8. Salvăm interogarea. 
Exemplu:  
Pentru tabela următoare: 

 
 
 
Eliminarea persoanelor care au studii "Liceale": 
 

 
Interogări de actualizare a înregistrărilor (Update Query) 
Se utilizează în cazul în care este necesară modificarea unui număr mare de înregistrari, respectând 
aceeaşi modalitate de modificare. Vom descrie în continuare modul de definire a unei interogări de 
actualizare.  

1. Creăm interogarea în modul Design View: selectăm Query din fereastra Database şi alegem 
modul de proiectare Design View. 

2. Includem tabela pentru care se execută interogarea. 

3. Selectăm Update Query din meniul Query. Ca rezultat, titlul ferestrei se modifică în Update 
Query, iar în partea de jos apare rândul Update To. 



4. Includem (prin “tragere”) în celulele rândului Field câmpurile care dorim să apară în 
interogare sau cele pentru care vom stabili criterii de actualizare. 

5. Pentru ca anumite câmpuri ale tabelei să fie afişate în interogarea de actualizare trebuie să 
introducem în rândul Update To numele câmpului cuprins între paranteze drepte, altfel 
acesta nu va fi afişat. De asemenea, putem completa automat un câmp calculat, care nu a 
fost completat iniţial în tabelă. De exemplu, dacă avem tabela Medii, care are câmpurile: 
Numele şi prenumele elevului, Media sem I, Media Sem II şi Media generală, iar câmpul 
Media generală nu a fost completat iniţial pentru nici o înregistrare, vom trece în dreptul 
câmpului Media generală de pe rândul Update: ([Media sem I]+[Media sem II])/2. 

 

6. Introducem în rândul Criteria condiţia pe care trebuie să o îndeplinească înregistrările care 
vor fi modificate. 

7. Vizualizăm interogarea în modul Datasheet View pentru a vedea modificările care se vor 
face. Modificările propriu-zise vor fi operate numai la revenirea în modul Design View şi 
executarea comenzii Run din meniul Query. ín acest caz, pe ecran va apărea un mesaj despre 
numarul total al înregistrărilor care urmează a fi modificate. Acţionând butonul Yes, Access 
va efectua modificările. Pentru a renunţa la modificări, acţionăm butonul No . 

Observaţie: Interogarile de tip Update se execută, de regulă, o singură dată. ín cazul executării 
repetate a interogării, de exemplu aplicarea unei scumpiri de 2% la pretul unor produse, această 
majorare va fi realizată la fiecare execuţie a interogării.  
Interogări de adăugare a înregistrărilor (Append Query) 
Se utilizează în cazul în care este necesară adăugareavunui set de înregistrări dintr-o tabelă în altă 
tabelă. Aceasta va selecta datele care tebuie adăugate şi le va trimite în câmpurile tabelei destinaţie. 
Vom descrie în continuare modul de definire a unei interogări de adăugare.  

1. Creăm interogarea în modul Design View: selectăm Query din fereastra Database şi alegem 
modul de proiectare Design View. 

2. Includem tabela pentru care se execută interogarea. 

3. Includem (prin "tragere") în celulele rândului Field câmpurile care dorim să apară în 
interogare sau cele pentru care vom stabili criterii de adăugare. 

4. Selectăm Append Query din meniul Query. Indicăm tabela destinaţie.  

 
Ca rezultat, titlul ferestrei se modifică în Append Query, iar în partea de jos apare rândul 
Append To. 



5. Introducem în rândul Criteria condiţia pe care trebuie să o îndeplinească înregistrările care 
vor fi preluate. 

6. Precizăm pe linia Append To numele câmpului destinaţie (doar în cazul în care nu au acelaşi 
nume). 

7. Vizualizăm interogarea în modul Datasheet View pentru a vedea modificările care se vor 
face. Modificările propriu-zise vor fi operate numai la revenirea în modul Design View şi 
executarea comenzii Run din meniul Query. 

 
 

5.Filtre: adăugare, eliminare 

Pentru filtrarea datelor dintr-o tabelă, interogare sau formular trebuie ca modul de vizualizare curent 
să fie Datasheet View. Operaţiile referitoare la filtrarea datelor se găsesc în meniul Records:  

 

Modalităţi de filtrare 
1)Filter By Selection- când dorim selectarea articolelor care conţin o anumită valoare pe care ne-am 
poziţionat anterior:  

• Ne poziţionăm pe valoarea căutată la unul din articole; 

• Selectăm Records->Filter->Filter By Selection; 

• Repetăm paşii anteriori până obţinem setul de date dorit. 



2)Filter Excluding Selection- când dorim selectarea articolelor care NU conţin o anumită valoare:  
• Ne poziţionăm pe valoarea căutată la unul din articole; 

• Selectăm Records->Filter->Filter Excluding Selection; 

• Repetăm paşii anteriori până obţinem setul de date dorit. 
3)Advanced Filter/Sort...- când dorim selectarea articolelor care îndeplinesc anumite condiţii:  

• Selectăm Records->Filter->Advanced Filter/Sort...; 

• Se deschide fereastra Filter care este, de fapt, o fereastră de proiectare a unei interogări, iar 
condiţia de filtrare se stabileşte în rândul Criteria, aşa cum se procedează la proiectarea unei 
interogări simple. Pentru a fi aplicat criteriul de filtrare se selectează Records->Apply 
Filter/Sort. Pentru anularea filtrării, se selectează Records->Remove Filter/Sort 

Exemplu: 
Fie tabela următoare:  

 
Pentru a afişa doar medicamentele care sunt produse de SC Prima SRL şi care au pretul>3 se 
stabilesc criteriile următoare:  

 
după care se alege Records->Apply Filter/Sort. 

Adăugarea, eliminarea de câmpuri într-o interogare 

Pentru a adăuga un câmp într-o interogare, se selectează coloana în care va apărea acesta şi se 
execută dublu clic pe câmpul tabelei sau al interogării care constituie sursa de date pentru 
interogarea curentă (vezi crearea interogărilor).  
 



 
 
Eliminarea unui câmp poate fi făcută fie prin debifarea casetei corespunzătoare din rândul Show al 
unei interogări simple, fie se selectează coloana care reţine câmpul şi se apasă tasta Delete.  

 
sau 

 
şi se apasă Delete. 

 
 

6. SELECTIA SI SORTAREA DATELOR DUPA CRITERII 

 Condiţiile de selecţie şi construirea lor 

Condiţiile de selecţie sunt expresii logice care vor fi verificate pentru ca articolele fişierelor sursă să 
fie trecute în fişierul virtual rezultat al interogării. Operatorii folosiţi sunt cei de comparare: < (mai 
mic),<= (mai mic sau egal),> (mai mare), >= (mai mare sau egal),<> (diferit), = (egal) şi / sau cei 
logici: And (şi logic) şi Or (sau logic). 

Exemple: 
Considerăm tabela sursă de mai jos:  



 
1. Dorim să afişăm toate persoanele care au vârsta cuprinsă între 30 şi 40 de ani şi care au studii 
universitare: 

 

Operatorul And este aplicat la nivel de câmp (>=30 And <=40) şi între câmpuri (condiţiile puse 
asupra câmpurilor Vârsta şi Nivel studii sunt pe aceeaşi linie).  

 
2. Dorim să afişăm toate persoanele care nu au vârsta cuprinsă între 40 şi 50 de ani sau care au 
studii Liceale: 

 

Operatorul Or este aplicat la nivel de câmp (<=40 Or >=50) şi între câmpuri (condiţiile puse asupra 
câmpurilor Vârsta şi Nivel studii sunt pe linii diferite).  

 
3. Pentru selectarea unor submulţimi de valori se pot utiliza caracterele de înlocuire: "*" - 
înlocuieşte un grup de caractere şi "?" - înlocuieşte un caracter. Dorim să afişăm persoanele care au 
telefon fix în reţeaua RDS:  



 

Cuvântul Like este asociat automat de sistem la folosirea acestor caractere de înlocuire.  
De asemenea, într-o interogare putem utiliza condiţiile IS NULL şi IS NOT NULL cu semnificaţia 
de valori vide, respectiv nevide într-o coloană. Dacă dorim afişarea persoanelor care nu au adresă 
de e-mail:  

 

Interogări de sortare a înregistrărilor 

După ce am definit condiţiile de selecţie, putem stabili condiţii de sortare pentru unul sau mai multe 
câmpuri. De exemplu, pentru afişarea persoanelor în ordine alfabetică executăm clic în rândul Sort 
al casetei, în dreptul câmpului Nume şi din lista derulantă alegem opţiunea Ascending. 

 

Pentru a afişa rezultatul interogării acţionăm butonul (Datasheet View) din bara cu instrumente.  
Sortarea datelor poate fi făcută şi fără a specifica condiţii de selecţie. în acest caz, se vor afişa toate 
înregistrările, dar ordinea lor va corespunde condiţiilor stabilite în rândul Sort pentru câmpurile 
respective.  

7. CREAREA SI UTILIZAREA RAPOARTELOR 

Crearea şi salvarea unui raport  

Se va realiza o bază de date care va conţine un tabel «Angajat» cu următoarele câmpuri: 
CNP(T,13), Nume(T, 15); Prenume(T,25), Data naşterii (Dată, scurtă), Clasa  

Pentru a crea un raport nou, va trebui să apăsaţi butonul Rapoarte (Reports) existent în partea 
stângă a ferestrei baza de date şi apoi să alegeţi opţiunea Creare raport utilizând Expertul 
(Create report by using wizard), după care va trebui să parcurgeţi paşii necesari pentru a crea 
raportul dorit.  

Pas 1 - Alegeţi tabela sau interogarea căreia doriţi să îi creaţi raportul şi atributele pe care doriţi să 
le conţină raportul. 



 

Pas 2 - La această etapă, vă alegeţi cum doriţi să fie structurat raportul. Vă puteţi grupa datele din 
tabelă sau din interogare după cum doriţi.  

 

Pas 3 – În această etapă stabiliţi dacă doriţi să sortaţi datele din raport şi vă puteţi alege modul în 
care să fie sortate datele (crescător sau descrescător).  



 

Pas 4 – În această etapă vă puteţi alege modul cum vor fi reprezentate datele în raport şi puteţi alege 
şi orientarea paginii raportului (Portrait sau Landscape).  

Pas 5 – Acum vă puteţi alege din stilurile predefinite stilul pe care doriţi să îl conţină raportul.  

 

Pas 6 - Aceasta este etapa finală în care vă alegeţi numele dorit pentru raport.  



 

Pe ecran va apărea fereastra raportului, în care puteţi vizualiza, datele corespunzătoare raportului 
creat.  

 

  

Adăugarea, modificarea antetului şi subsolului unui raport  

Se va realiza o bază de date care va conţine un tabel «Angajat» cu următoarele câmpuri: 
CNP(T,13), Nume(T, 15), Prenume(T,25), Data naşterii (Data, scurta), Clasa  

Pentru a adăuga text sau imagine în antetul sau subsolul unui raport, este necesar să deschideţi 
raportul prin apăsarea butonului Proiect.  

Pe ecran va apărea constructorul de rapoarte în care puteţi să modificaţi ceea ce doriţi. 



 

Pe ecran va apărea şi o bară de instrumente corespunzătoare constructorului de rapoarte, prin 
intermediul căreia puteţi realiza diferite modificări în raport. Pentru a introduce un text în antet sau 
în subsol, va trebui cu ajutorul mouse-ului să trageţi de antet sau de subsol şi apoi în spaţiul creat 
introduceţi textul dorit. Pentru a putea introduce un text în antet sau subsol va trebui să apăsaţi 
butonul de pe bara de instrumente. După apăsarea acestui buton, selectaţi în antet locul unde 
doriţi să fie poziţionat textul şi apoi introduceţi textul dorit.  

 

După introducerea textului salvaţi raportul şi pentru a vedea modificările făcute deschideţi raportul .  

 

Asemănător puteţi modifica şi subsolul raportului, sau puteţi introduce diferite imagini în antet sau 
subsol cu ajutorul comenzii Insert-Picture.  



Microsoft Access vă salvează automat ceea ce aţi modificat. Pentru o mai mare siguranţă puteţi 
apăsa butonul Save existent pe bara de instrumente a aplicaţiei, sau puteţi apela funcţia Save 
existentă în meniul File.  

Puteţi şterge un raport prin apăsarea butonului existent în partea de sus a ferestrei bazei de date 
după ce aţi selectat raportul dorit sau prin alegerea opţiunii Delete din meniul apărut după ce aţi dat 
clic dreapta pe raportul pe care doriţi să-l ştergeţi.  

Selectaţi raportul pe care doriţi să îl ştergeţi şi apoi apăsaţi butonul Delete existent pe tastatură.  

Pe ecran va apărea o casetă de dialog în care vi se cere confirmarea ştergerii raportului.  

Pentru a şterge raportul definitiv apăsaţi butonul Yes, pentru a renunţa la ştergere apăsaţi butonul 
No.  

Închiderea unui raport se realizează prin apăsarea butonului din partea dreapta a raportului sau prin 
alegerea din meniul File a opţiunii Close.  

Gruparea datelor într-un raport, total-raport, subtotal-raport  
Microsoft Office Access 2007 

În orice raport care conţine numere, aveţi posibilitatea să utilizaţi totaluri, medii, procente sau să 
efectuaţi sume pentru a face datele mai inteligibile. În acest sens, puteţi adăuga astfel de elemente la 
raport printr-una din situaţiile propuse:  

1. Adăugarea unui total sau a altei funcţii agregate în Vizualizare aspect  

2. Adăugarea unui total sau a altei funcţii agregate în Vizualizare proiect  

3. Calcularea unei valori de procent  

4. Calcularea unei sume efectuate (total cumulativ)  

1. Adăugarea unui total sau a altei funcţii agregate în Vizualizare aspect  

Vizualizarea aspect furnizează modalitatea cea mai simplă de adăugare a totalurilor, 
mediilor şi a altor funcţii agregate la raport. Deci:  

•  În Panoul de navigare, faceţi clic cu butonul din dreapta pe raport şi faceţi clic pe 
Vizualizare aspect  

•  Faceţi clic pe câmpul pe care doriţi să îl adunaţi. De exemplu, pentru a adăuga un total la 
o coloană de numere, faceţi clic pe unul dintre numerele din coloană.  

•  În fila Forma, în grupul Grupare şi totaluri, faceţi clic pe Totaluri .  

•  Faceţi clic pe tipul de funcţie agregată pe care doriţi să o adăugaţi la câmp.  

În tabelul următor găsim tipurile de funcţii agregate din Microsoft Office Access 2007 pe 
care aveţi posibilitatea să le adăugaţi la un raport.  

Calculare  Descriere  Funcţie  

Sumă  Suma tuturor numerelor din coloană.  Sum()  

Medie  Valoarea medie a tuturor numerelor din coloană.  Avg()  



Contor  Adunarea elementelor din coloană.  Count()  

Maximum  Cea mai mare valoare numerică sau alfabetică din coloană.  Max()  

Minimum  Cea mai mică valoare numerică sau alfabetică din coloană.  Min()  

Deviere standard  O estimare a devierii standard a setului de valori din coloană.  StDev()  

Varianţă  O estimare a varianţei setului de valori din coloană.  Var()  

Office Access 2007 adaugă o casetă text la secţiunea Subsol de raport (subsol de raport: 
Secţiune dintr-un raport care este utilizată pentru a plasa informaţii ce în mod normal apar în 
partea de jos a unei pagini, cum ar fi numărul de pagină, datele şi sumele.) şi îi setează 
proprietatea Sursă control la o expresie care efectuează calculul care vă trebuie. Dacă nu se 
află niciun nivel de grupare în raport, Access adaugă, de asemenea, o casetă text care 
efectuează acelaşi calcul pentru fiecare secţiune Subsol de grup (subsol de grup: Utilizat 
pentru a plasa informaţii, cum ar fi numele de grup sau totalul de grup, la sfârşitul unui grup 
de înregistrări).  

2. Adăugarea unui total sau a altei funcţii agregate în Vizualizare proiect  

Vizualizarea proiect vă oferă mai mult control asupra amplasării şi aspectului totalurilor. În 
rapoartele grupate, aveţi posibilitatea să aşezaţi totalurile sau alte funcţii agregate în antetul 
sau subsolul fiecărui grup. Funcţiile agregate care cuprind întregul raport se pot amplasa în 
secţiunea Antet de raport (antet de raport: Secţiune dintr-un raport utilizată pentru plasarea 
de informaţii (cum ar fi titlul, data sau o prefaţă) la începutul unui raport.) sau Subsol de 
raport.  

•  Deschideţi un raport în Vizualizare proiect.  

•  În fila Proiect, în grupul Controale, faceţi clic pe Casetă text .  

•  Alegeţi una dintre variantele următoare:  

-  Pentru a calcula un total sau o medie pentru un grup de înregistrări, faceţi clic în secţiunea 
Antet de grup (antet de grup: Utilizat pentru a plasa informaţii, cum ar fi numele de grup sau 
totalul de grup, la începutul unui grup de înregistrări) sau Subsol de grup.  

-  Pentru a calcula un total general sau o medie pentru toate înregistrările din raport, faceţi 
clic în secţiunea Antet de grup sau Subsol de grup.  

Caseta text se inserează în secţiunea pe care faceţi clic.  

•  Selectaţi caseta text. Dacă foaia de proprietăţi nu este afişată deja, apăsaţi F4 pentru a o 
afişa.  

•  Faceţi clic pe fila Date . În caseta de proprietăţi Sursă control , tastaţi o expresie care 
utilizează funcţia Sumă pentru calcularea totalului sau funcţia Avg pentru calcularea mediei.  

De exemplu : =Sum(Freight) sau =Avg(Freight); (freight=produsul de încărcat/calculat)  

Indicaţie: Pentru ajutor la construirea expresiei, aveţi posibilitatea să utilizaţi Generatorul 
de expresii. Pentru a deschide Generatorul de expresii, faceţi clic pe în caseta de 
proprietăţi Sursă control.  



Notă:  Când calculaţi un total în Vizualizare proiect utilizând o funcţie agregată (funcţie 
agregată: O funcţie, cum ar fi Sum, Count, Avg, or Var, utilizată pentru calcularea 
totalurilor), cum ar fi Sumă sau utilizând o funcţie agregat de domeniu (funcţie agregată de 
domeniu: O funcţie, cum ar fi DAvg sau DMax, care se utilizează pentru a calcula statistici 
pentru un set de înregistrări (un domeniu), cum ar fi DSum , nu aveţi posibilitatea să utilizaţi 
în funcţie numele unui control calculat (control calculat: Control care se utilizează într-un 
formular, raport sau într-o pagină de acces la date pentru a afişa rezultatul unei expresii. 
Rezultatul este recalculat de fiecare dată când se efectuează o modificare a vreuneia dintre 
valorile pe care se bazează expresia.). Trebuie să repetaţi expresia (expresie: Orice 
combinaţie de operatori matematici sau logici, constante, funcţii şi nume de câmpuri, 
controale şi proprietăţi evaluate ca valoare unică. Expresiile efectuează calcule, manipulează 
caractere sau testează date în controlul calculat.  

De exemplu : =Sum([Cantitate] * [PreţUnitar])  

Cu toate acestea, dacă aveţi un câmp calculat (câmp calculat: Un câmp, definit într-o 
interogare, care afişează rezultatul unei expresii şi nu afişează date stocate. Valoarea se 
recalculează de fiecare dată când se modifică o valoare din expresie) într-o interogare 
(interogare: Chestionare a datelor stocate în tabele sau cerere de efectuare a unei acţiuni 
asupra datelor. O interogare poate alătura date din mai multe tabele pentru a servi ca sursă 
de date pentru un formular sau raport) de bază, cum ar fi: =PreţDetaliat: [Cantitate] * 
[PreţUnitar], aveţi posibilitatea să utilizaţi numele câmpului respectiv în funcţia Sumă, aşa 
cum se arată aici: =Sum([PreţDetaliat])  

3. Calcularea unei valori de procent  

•  În Panoul de navigare, faceţi clic cu butonul din dreapta pe raport, apoi faceţi clic pe 
Vizualizare proiect în meniul de comenzi rapide.  

•  În fila Proiect, în grupul Controale, faceţi clic pe Casetă text .  

•  Alegeţi una dintre variantele următoare sau ambele variante:  

-   Dacă raportul nu calculează totaluri de grup, faceţi clic pe secţiunea Subsol de grup 
pentru a adăuga caseta text pentru a afişa totalurile de grup.  

-  Dacă raportul nu calculează un total general, adăugaţi o casetă text la secţiunea Subsol de 
raport, pentru a afişa totalul general.  

•  Alegeţi una dintre variantele următoare sau ambele variante:  

-  Pentru a calcula procentajul unui total de grup sau totalul general pe care îl reprezintă un 
element, adăugaţi o casetă text la secţiunea Detalii (secţiunea detalii: Utilizată pentru a 
cuprinde corpul principal al unui formular sau raport. Această secţiune conţine de obicei 
controale legate la câmpurile din sursa înregistrărilor, dar este posibil să conţină şi controale 
nelegate, cum ar fi etichetele care identifică conţinutul câmpurilor.).  

-  Pentru a calcula procentajul unui total general pe care îl reprezintă un grup de elemente, 
adăugaţi o casetă text la secţiunea Antet de grup sau Subsol de grup.  

Notă: Dacă raportul include mai multe niveluri de grup (nivel de grup: Adâncimea până la 
care este imbricat un grup în interiorul altor grupuri într-un raport sau pagină de acces la 
date. Grupurile sunt imbricate când un set de înregistrări este grupat după mai multe 
câmpuri, expresii sau surse de înregistrări ale grupului), plasaţi caseta text în antetul sau 
subsolul nivelului căruia doriţi ca Access să îi calculeze procentul.  



•  Selectaţi caseta text. Dacă foaia de proprietăţi nu este afişată deja, apăsaţi F4 pentru a o 
afişa.  

•  Faceţi clic pe fila Date . În caseta de proprietăţi Sursă control, tastaţi o expresie care 
împarte totalul mai mic după totalul mare din care face parte acesta.  

De exemplu : =[DailyTotal]/[GrandTotal]  

Indicatie: Aveţi posibilitatea să faceţi clic pe pentru a utiliza Generatorul de expresii 
(Generator de expresii: Instrument Access care se utilizează pentru crearea unei expresii. El 
include o listă de expresii obişnuite care pot fi selectate) la crearea expresiei.  

•  Setaţi proprietatea Format a casetei text la Procent.  

4. Calcularea unei sume efectuate (total cumulativ)  

Pentru a crea o sumă în execuţie într-un raport, aveţi posibilitatea să utilizaţi Office Access 2007. O 
sumă în execuţie este un total acumulat de la o înregistrare la alta din cadrul unui grup sau chiar a 
unui întreg raport.  

 

Crearea unei sume în execuţie  

•  În Panoul de navigare, faceţi clic cu butonul din dreapta pe raport, apoi faceţi clic pe Vizualizare 
proiect în meniul de comenzi rapide.  

•  În fila Proiect, în grupul Controale, faceţi clic pe Casetă text .  

•  Pentru a crea o casetă text, faceţi clic pe secţiunea Detalii, pe secţiunea Antet de grup sau pe 
secţiunea Subsol de grup. Dacă lângă caseta text apare o etichetă, ştergeţi eticheta sau modificaţi 
textul ei într-o valoare semnificativă.  

•  Selectaţi caseta text. Dacă foaia de proprietăţi nu este afişată deja, apăsaţi F4 pentru a o afişa.  

•  Faceţi clic pe fila Date . În caseta de proprietăţi Sursă control, tastaţi numele de câmp sau 
expresia pentru care doriţi să creaţi suma în execuţie.  

De exemplu: tastaţi PreţDetaliat pentru câmpul PreţDetaliat sau la nivelul grupului, tastaţi expresia 
=Sum([PreţDetaliat]) .  

•  Faceţi clic pe caseta de proprietăţi Execuţie sumă.  



•  Faceţi clic pe săgeata verticală din caseta de proprietăţi, apoi alegeţi una dintre variantele 
următoare:  

-  Pentru ca suma în execuţie să se reiniţializeze la 0 când se atinge nivelul de grupare mai mare 
următor, selectaţi Peste grup în listă.  

-  Pentru ca suma în execuţie să cumuleze până la terminarea raportului, selectaţi Peste tot în listă.  

•  Închideţi foia de proprietăţi.  

Indicaţie:  Când setaţi proprietatea Execuţie sumă la Peste tot, aveţi posibilitatea să repetaţi totalul 
general în secţiunea Subsol de raport. Creaţi o casetă text în subsolul raportului şi setaţi-i 
proprietatea Sursă control la numele casetei text care calculează suma în execuţie;  

De exemplu : =[NumărDeComenzi] .  

   

http://office.microsoft.com/ro-ro/access-help/adunarea-in-rapoarte-HA010120854.aspx?CTT=3  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Aplicaţie 1 - Access  

1. Creaţi o bază de date nouă în directorul My Documents. Salvaţi-o cu numele dumneavoastră. 

2. Creaţi o tabelă cu următoarele câmpuri: 

Cod AutoNumber  
Titlu Text de dimensiune 50  
Autor Text de dimensiune 30  
Editura Text de dimensiune 40  
Data apariţiei Date/Time - Medium Date  
Preţ Number - Double  
Coperta OLE Object 

3. Stabiliţi ca şi cheie primară câmpul Cod.  

4. Salvaţi tabela cu numele Cărţi.  

5. Creaţi un formular nou asupra tabelei Cărţi. 

6. Salvaţi formularul cu denumirea Formular Cărţi.  

7. Introduceţi următoarele 6 înregistrări în tabela Cărţi cu ajutorul formei create.  

Cod Titlu Autor Editura Data 
apariţiei  Pret Coperta 

1 Computing for the 
Older Generation 

James 
Gatenby 

Bernard Babani 
Publishing 

01 ian. 
2003 58,67 

 

2 Windows 95 For 
Dummies 

Andy 
Rathbone 

Hoboken, 
United States 

28 feb. 
1997 124,99 

 

3 Windows XP 
Quicksteps 

Martin S 
Matthews 

McGraw-Hill 
Education 

01 mar. 
2004 85,34 

 

4 
Understanding 
Computer Science 
for Advanced Level 

Ray Bradley Trans-Atlantic 
Pubns 

01 iul. 
1999 305,32  

 



5 Windows VistaTM 
For Dummies 

Andy 
Rathbone 

Hoboken, 
United States 

29 nov. 
2006 103,12  

 

6 Programming Perl Larry Wall O'Reilly Media 14 iul. 
2000 253,50  

 

8. Utilizaţi instrumentul de căutare pentru a găsi autorul Ray Bradley. 

9. Adăugaţi următorul atribut Număr_telefon (text de dimensiune 10) tabelei Cărţi.  

10. Modificaţi lungimea coloanei Titlu din tabela Cărţi la 70 de caractere.  

11. Creaţi o interogare asupra tabelei Cărţi în care afişaţi doar cărţile care au preţul mai mare de 
200 lei. 

12. Creaţi un raport asupra tabelei Cărţi. 

13. Introduceţi în antetul raportului o imagine. 

14. Mutaţi imaginea în partea stângă a raportului. 

15. Salvaţi modificările făcute şi închideţi aplicaţia de baze de date. 
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